
Microsoft Word is a widely used commercial word processor designed by Microsoft. 

Microsoft Word is a component of the Microsoft Office suite of productivity 

software, but can also be purchased as a stand-alone product. 

Microsoft Word was initially launched in 1983, and has since been revised numerous 

times. It is available for both Windows and Apple operating systems. 

Microsoft Word is often called simply Word or MS Word. 

Microsoft Word 



Word Processing Features

*Create professional-looking documents quickly and easily

*Create table of contents, indexes, and cross-references for large documents 

*AutoCorrect and AutoFormat automatically correct typographical errors and format documents 

using established shortcuts and typing patterns

*The print zoom feature allows you to print many pages on a single sheet of paper

*Export and save your word documents in PDF and other file format 

*Spend more time writing, less formatting

*Add preformatted items in a matter of seconds

* Increase your effectiveness with the use of high-impact images

*Instantly give your documents a new look and feel

*Easily avoid spelling errors



Launch MS Word 

*To start MS Word 2019, click on the Start button, and then select Microsoft 

Word from the options panel.

The Microsoft Word Icon can be pin to the start bar for quick access



Window and Ribbon Features 

The screen shot below displays the primary components of the Word 2019 interface. 





The table below consists of definitions for the Microsoft Office features. 



Microsoft Word 2019 uses Tabs instead of menus to organize various functions. In addition, 

command buttons have been placed in a Group within the Ribbon. The Dialog Box Launcher 

in a group shows additional options. 

Difference of Tools Menu between old version Word and new Word





The File tab provides you with the Backstage that 

provides information pertaining to your document and 

options to help setup your window defaults. The 

Backstage also contains standard commands such as, 

Home, Save, Save As, New, Print, etc. 

File Tab 



Templates 
Microsoft Office has a variety of predesigned templates within specific categories. 

Open Templates 

1. Select the File tab, and then click on the New option. 

2. The Available Templates window will appear. 



Quick Access Toolbar 
Microsoft Word 2019 has a Quick Access Toolbar, so you can have quick access to your 

most used commands. 



Add Commands 

1. To add your most used commands to the 

Quick Access Toolbar, click on the drop-down 

arrow next to the Quick Access Toolbar. 

2. The Customize Quick Access Toolbar 

option panel will appear. 
3. Click on your desired command option to be 

placed on the Quick Access Toolbar. 



Save a document

Save your document to OneDrive so you can get to it from anywhere – at work, at home, or on the go. Or 

save to another location, like your desktop.

1- On the File tab, select Save As or Save a Copy.

2- In the Save dialog, select OneDrive.

3- Update the name and file type if  you want, and select Save file button in the save dialog Save. 

4- Save personal files to OneDrive - Personal, and work files to your company OneDrive or SharePoint site.

5- Select Browse, and navigate to any location including the Desktop.

6- Enter a name, and select Save file button in the save dialog Save.

**note : When you save to OneDrive or SharePoint, all your changes are saved automatically. You can turn 

AutoSave on or off  on the Quick Access Toolbar, either above or below your ribbon. 





Selection and Editing Text

There are multiple ways to select and edit text to entire paragraphs at once.

* Click and drag across the text you want to select. You can select any amount of text with this 

method, from a single character to your entire document.

* Press and hold down the Shift key, and move the insertion point either. with your mouse or the 

arrow keys to select text.

*Double-click a single word to select it.

* Press the Ctrl key and click on a sentence to select it.

*Triple-click in a paragraph

*Press Ctrl + A to select everything in the document.



Keyboard to select Text



Press the F8 key twice to select current word on which insertion pointer is

• Press the F8 key three times to select the current sentence

• Press the F8 key four times to select the current paragraph as a block of  text

• Press the F8 key five times to select the entire document (top to bottom)

• Irrespective of  number of  times F8 key is pressed, Word will be still in Extend Selection mode. 

Esc to cancel

Keyboard to select Text



Cut, copy, and paste

* Cut  :  Select Cut Click Cut Word or press Ctrl + X.

* Copy : Select Copy Click Copy Word or press Ctrl + C.

* Paste : Select Paste Click Paste Word or press Ctrl + V.

Note:  Paste only uses your most recently copied or cut item.





















Changing font color

To change the font color in a Microsoft Word document, follow the steps below.

1.Highlight the text you want to change.

2.Click the down arrow next to the color icon on the formatting bar or Ribbon. It is 

usually displayed as the letter "A" with a red underline.

3.After clicking the down arrow, select a color for the text.

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


Changing font size

To change the font size in a Microsoft Word document, follow the steps below.

1.Highlight the text you want to change.

2.Click the down arrow next to the size box on the formatting bar or Ribbon to enlarge or reduce the 

font size. The default font size is usually 11 or 12.

3.After clicking the down arrow for the size, you see a list of predesignated sizes to select. Some 

fonts do not scale appropriately to have limited size options.

4.You can also change the font size by clicking and highlighting the current default size. In the 

picture above, the default is 11. Once highlighted, you can type in a number. For example, to use 

font size 100, you can type in that number rather than choosing a preset number from the list.

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


Changing font style

To change the font style, including bold, italic, and underline, follow the steps below in a Microsoft 

Word document.

1.Highlight the text you want to change.

2.Click the B, I, or U option on the formatting bar or Ribbon to change the text to bold, italic, or 

underlined.

3.After clicking the B, I, or U option, the text changes to the selected font style. 

Note: Alternatively, use the keyboard shortcuts Ctrl+B for bold, Ctrl+I for italic, and Ctrl+U for 

underline.

Alternatively, use the keyboard shortcuts Ctrl+B for bold, Ctrl+I for italic, and Ctrl+U for underline. 

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/c/ctrl-b.htm
https://www.computerhope.com/jargon/c/ctrl-i.htm
https://www.computerhope.com/jargon/c/ctrl-u.htm


Changing font type

To change the font type in a Microsoft Word document, follow the steps below.

1.Highlight the text you want to change.

2.Click the down arrow next to the font field on the formatting bar or Ribbon. 

3.After clicking the down arrow for the font, select the desired font from the list of installed fonts on 

your computer, like Arial, Calibri, and Times New Roman.

https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm
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6 7 8 9 10 11 141312

1- Font - (Ctrl + Shift + F). Provides A List Of All The Available Fonts (Based On Your Current Printer Selection).
2- Font Size - (Ctrl + Shift + P). Lets you adjust the character size (based on your current printer selection).
3- Increase Font Size - (Ctr + Shift + >). Increases the font size of the current selection to the next larger size in the 
Font Size box.
Decrease Font Size - (Ctrl + Shift + <). Decreases the font size of the current selection to the next smaller size in the 
Font Size box.
4-Change Case - Drop-Down. Changes the selected text to either uppercase, lowercase or another type of 
capitalisation. The drop-down contains the commands: Sentence Case, Lowercase, Uppercase, Capitalize Each 
Word and Toggle Case.



5- Clear All Formatting - (Ctrl + Spacebar). Clears all the formatting from the current selection.

6- Bold - (Ctrl + B). Toggles bold on the current selection.

7- Italic - (Ctrl + I). Toggles italics on the current selection.

8- Underline - (Ctrl + U). Button with Drop-Down. The button toggles bold on the current selection. The 

drop-down contains the commands: Underline, Double Underline, Thick Underline, Dotted Underline, 

Dashed Underline.

9- Strikethrough - Draws a line through the middle of the selected text.

10- Subscript - (Ctrl + =). Converts the selection to small letters below the text baseline.

11- Superscript - (Ctrl + Shift + +). Converts the selection to small letters above the text baseline.

12 Text Effects and Typography - Drop-Down. Apply text effects such as Outline, Shadow, Reflection, Glow, 

Number Styles, Ligatures and Stylistic Sets.

13- Text Highlight Color - Button with Drop-Down. Shades the background behind the current 

selection.The drop-down contains the commands: No Color and Stop Highlighting. For more details please 

refer to the Characters > Text Highlight page.

14- Font Color - Button with Drop-Down. The button changes the colour of the font of the current 

selection. The drop-down contains the commands: Automatic, Theme Colors, Standard Colors and More 

Colors.

https://bettersolutions.com/word/characters/text-highlight.htm


1 2 3 4

5 6 7 8

1- Bullets – Creates a list with bullets.
2- Numbering – Makes a list with numbers.
3- right to left text direction – left to right text direction
4- Sort – Organizes data in alphabetical order.
5- Align Left – Text is aligned with the left margin.
Center – Text is centered in the document.
Align Right– Text is aligned with the right margin.
6- Line and Paragraph Spacing – Modifies the distance 
between lines and paragraphs.
7- Shading – Changes the background color of the text.
8- Borders – Creates lines surrounding text.



Styles

The styles group is found on the Home Tab, contains a collection of quick styles.

•Page Formatting Styles – Creates various styles and previews them in the text.



Editing

The Editing Group is located at the far right end of the Home Tab. There are three options for the 

Editing Group, two of which are drop-down menus. Commands in editing group includes the 

following:

•Find – Locates words within a document.

•Replace – Searches the document for text to replace.

•Select – Selects all or a portion of the document’s text.



* Cover Page – Creates a document’s cover page.

* Blank Page – Inserts a blank page anywhere specified in the document.

* Page Break – Where specified, ends the current page and moves the 

remaining text to the next page.



Tables

•Table -Creates a new table or inserts 

an existing table into the document.



Here are list of commands under Illustrations group. By clicking on the dialog box 

launcher in the bottom right corner of this group other option will display.

•Pictures -Inserts photos in your document.

•Shapes – Add shapes to your document..

•Icons – This function inserts icons into your document.

•3D Models – Adds a 3D model to your document.

•SmartArt – In your document, inserts a SmartArt graph or list.

•Chart – This function generates a chart to display your data.

•Screenshot – This function inserts a screenshot into your document.

Illustrations



Links

•Link – Inserts a link for web pages in your document.

•Bookmark – Creates a specific spot in your document that can be jumped to 

without having to scroll.

•Cross-reference – Refers to a specific place in the document, such as a heading 

or table.



Comments

Comments can be added to a document that do not change the document. 

Adds notes in specific places in the document.



Header & Footer

Headers and footers are at the top and bottom of the document. They are separate 

from the main document and are often used to hold footnotes, page numbers, titles, 

and other information. The available commands in Header & Footer includes the 

following.

•Header – Adds repeat content to the top of every page in the document.

•Footer – Adds repeat content to the bottom of every page in the document.

•Page Number – Adds page numbers to each page of your document.



Text

* Text Box – Adds a custom text box that draws emphasis to the text.

* Quick Parts -Inserts text or formatting that has been previously saved into a 

document.

* WordArt – Adds aesthetic flourishes to this box’s text.

* Drop Cap – This box’s text is enhanced with creative flourishes.

* Signature Line – The signature line is added to the document.

* Date & Time – Options for adding the date and time to the document.

* Object – Adds an additional document or chart to the current document.



Symbols

•Symbol – Adds symbols to the document, such as currency and trademark.

•Equation – Adds mathematical equations to the document.



Equation - Button with Drop-Down. The button inserts an equation at the current 

location and then displays the Equation Tools - Design Tab. The drop-down contains 

the following built-in equations: Area of Circle, Binomial Theorem, Expansion of a 

Sum, Fourier Series, Pythagorean Theorem, Quadratic Formula. At the bottom are 

the commands: Insert New Equation and Save Selection to Equation Gallery.

https://bettersolutions.com/word/illustrations/equation-tools-design-tab.htm


Document Formatting

The commands of Document Formatting group.

* Themes – Adds custom formatting to the document.

* Colors – Changes the entire color palette of the document to a color scheme of 

your choice.

* Fonts – Changes the font of the document.

* Paragraph Spacing – Changes the line and paragraph spacing of the document.

* Effects – Changes the overall look of objects with shading and other options.

* Set as Default – Sets the current formatting as the default for new documents.



Page background

•Watermark – Adds a faint image behind the text of your document.

•Page Color – Changes the background color of the document.

•Page Borders – Adds a border around the document.



Page Setup

Page setup is a set of rules that control how a printed page looks and is laid out.

•Margins – Sets the margin sizes for the document.

•Orientation – Changes the orientation of the document to portrait or landscape mode.

•Size – Selects the size of paper for printing.

•Columns – Splits the page into up to 13 columns.

•Breaks – Ends the current page at your desired location, and starts the remainder of the 

information on the next page.

•Line Numbers – Adds numbers to each line for easy reference to a specific location.

•Hyphenation – Automatically hyphenates words that extend beyond the end of a line. 

Hyphenation is placed at syllable boundaries.



Paragraph

•Indent Left – Moves the paragraph away from the left margin.

•Indent Right – Moves the paragraph away from the right margin.

•Spacing Before – Changes how much spacing is before the selected paragraph.

•Spacing After – Changes how much spacing is after the selected paragraph.
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